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Tasks & Resources
In the life cycle of a project, there are various non-technical
tasks that are vital to the successful management and
completion of the project, such as allocation of resources
and allocation of time to the tasks and to meetings.
Enterprise Architect helps you as a project manager or as a
team member to record and monitor such tasks.

Facilities

Enterprise Architect provides a range of project
management facilities as described in this table.

Facility Description

Manage
Project
Resources

Resources are the people who work on a
project. You can assign roles and allocate
tasks to them, which helps you to track
effort and estimate time to complete
tasks. You can also define the effort, risks
and metrics to support resource
management. You add, modify and delete
resources using the Resource Allocation
window.

The Project
Gantt View

In Enterprise Architect, you can visualize
elements and assigned project resources
easily in a Gantt Chart format, to review
the breakdown of work for a specific
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project and for specific sections of the
project. The Project Gantt View
illustrates a project schedule by showing
the start and finish dates of assigned
resources, so that you as Project Manager
can quickly see the current project status
using the percent-complete bar shading
and the percent-complete, resource name
and status columns. Information can be
filtered, and overdue items can quickly be
highlighted and identified. You can also
access specialized versions of the Project
Gantt View from diagrams, Packages and
the Personal Tasks list.

Project Task
Allocation

A particular feature of the Project Gantt
View is the facility to review the
allocation of work to elements in the
project, focusing on either the elements
that require work, or the resources
required to perform the work.

Review
Personal
Tasks

Using the Personal Tasks view, each
team member can record, review and
manage their personal work within the
project.

Project
Management

Enterprise Architect provides five
specialized tabs in the Project Tools
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Windows window to help you to define each of the
management quantities associated with an
element in the model, namely:

Decisions - the choice made on a·

requirement of the element
Events - the action taken on a·

requirement of the element
Effort - the effort expended in work on·

the element
Risks - the risks associated with the·

element, and
Metrics - the metrics measured for an·

element

Notes

In the Corporate, Unified and Ultimate Editions of·

Enterprise Architect, if User Security is enabled, you must
have 'Manage Project Settings' permission to perform
Resource Allocation
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Project Resources
Resources are the people who work on a project. They can
be assigned roles and allocated tasks, which enables
tracking of effort and estimation of time to complete. You
also define the effort, risks, metrics, events and decisions to
support resource management.

You can also review and delete listed allocated resources
using the Resource Allocation window.

Access

Ribbon Construct > Resource Management >
Resources

Keyboard
Shortcuts

Select a Resource item on a diagram or
on the 'Details' tab of the Inspector
window, then press Shift+Enter

Uses

Use to

Allocate a resource to an element.

(c) Sparx Systems 2025 Page   6 of 109



Tasks & Resources 2 September, 2025

Record additional project management information for an
element.

Obtain a report of resource allocation details.

Show Project Management information on elements in a
diagram.

Configure Project Management data and populate the
drop-down lists used on the tabs of the Project Tools
window.

Notes

In the Corporate, Unified and Ultimate Editions of·

Enterprise Architect, if User Security is enabled, you must
have 'Manage Project Settings' permission to perform
Resource Allocation and to update and manage project
resources, effort, metrics, risks, decisions and events
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Resource Allocation
In developing a model, people (or resources) in a number of
roles might perform tasks on model structures. As a Project
Manager, you can assign resources to tasks on elements
(including Packages) in the model, planning and monitoring
the work that they do within the timeframe you have
allocated for that work to be completed. You can do this
using the Project Gantt View and/or Construct facilities.

The Resource Allocation window, displays a Gantt chart
that shows all of the resources assigned to a particular model
element.  As you select different model elements, the Gantt
chart updates to show the resources assigned to the selected
element.  As you select an individual resource on the Gantt
chart, the Properties window and the Notes window (if
visible) will update to show the details for the selected
resource.

Access

Ribbon Construct > Resource Management >
Resources,  or
Start > All Windows > Construct >
Resources > Resource Allocation

Create Resource Allocations
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New resource allocations are made using the 'Assign
Resources' dialog.  To access the dialog, first select a model
element for which you wish to create resource allocations
and then, either:

Click on the   button in the Resource Allocation·

window toolbar, or

Right-click on the Gantt Chart and choose the context·

menu option 'Assign Resource...'.

Assign Resources Dialog

The initial details for a resource allocation are entered using
the 'Assign Resources' dialog.

This table describes the fields appearing on the dialog.

Field Action
Resource

Click on the drop-down arrow and click
on the name of the resource to assign to
work associated with the element.
To assign multiple resources at once,
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click on the browse button, then select the
resources to assign from the 'Select
Resources' dialog.
(You can type the name of the resource
into the 'Resource' field, as long as the
name is one of those defined in the
system; if it is not, the assignment will
not validate. As you type, the field
auto-fills with names matching the
characters that you have typed.)

Role or Task

Click on the drop-down arrow and click
on the required role of the resource in this
task. You cannot type a role into the field.
The field initially defaults to the first role
in the defined list; in subsequent
assignment entries, the role defaults to
the one posted for the immediately
previous assignment to this or any other
element.

Start Date

This field defaults to today's date.
If you want to assign a different start date
for the task:

Click on the drop-down arrow.1.
If necessary, click on the Left or Right2.
Arrow to select the previous or next
month.
Click on the appropriate day of the3.
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month as the start date.
The field immediately changes to the
selected date.

End Date

This field defaults to today's date.
If you want to assign a different end date
for the task:

Click on the drop-down arrow.1.
If necessary, click on the Right Arrow2.
to select the next month.
Click on the appropriate day of the3.
month as the end date.

The field immediately changes to the
selected date.

Save / Save & Close

To save the resource allocation you have
defined, click on one of the 'Save'
buttons.
If you intend to define further resource
allocations for the same model element,
click the Save button - the dialog will
remain open, ready for you to create
another allocation.
When you have finished creating
allocations for the selected model
element, click 'Save & Close' (or 'Close'),
to close the dialog.
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Modify Existing Resource Allocations

Existing resource allocations can be modified directly on the
Gantt chart, by dragging the start or end dates to a new
position on the time line, or by dragging the entire task to a
new position.

The percentage completed can also be updated by clicking
on the value and dragging a slider (or using the left and right
arrow keys) to select a new value.

If the Properties window is visible, the resource allocation's
properties can be updated there, by simply entering new
values. Similarly, if the Notes window is visible, entries for
Description and History can be updated directly in the Notes
window.
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Alternatively, you can use a dialog designed specifically for
this purpose.

To use the dialog, first select the model element for which to
modify resource allocations; then, in the Resource
Allocation window, double-click the allocation to be
modified, or right-click and choose the menu option 'Modify
Resource'.

Modify Resource Allocations Dialog

The 'Modify Resource Allocations' dialog, is used to update
the details of existing Resource Allocations.
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This table presents a detailed description of each field on the
'Modify Resource Allocations' dialog and how it is intended
to be used.

Field Action
Resource

Click on the drop-down arrow and click
on the name of the resource to assign to
work associated with the element.
To assign multiple resources at once,
click on the browse button, then select the
resources to assign from the 'Assign
Resource' dialog.
(You can type the name of the resource
into the 'Resource', as long as the name is
one of those defined in the system; if it is
not, the assignment will not validate. As
you type, the field auto-fills with names
matching the characters that you have
typed.)

Role or Task
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Click on the drop-down arrow and click
on the required role of the resource in this
task. You cannot type a role into the field.
The field initially defaults to the first role
in the defined list; in subsequent
assignment entries, the role defaults to
the one posted for the immediately
previous assignment to this or any other
element.

Description

Type (and, if you prefer, format) a
description of the work being done by the
resources.

History

As the task progresses, you add text to
this tab to record the activities, progress,
problems and outcomes of the task.

Expected Time

Type in the number of time units the task
is expected to take. (The value must be an
integer, so you cannot record part units.)

The unit of time you adopt is by
agreement within the project, and
depends on the granularity of the work
being recorded. Most tasks are completed
in a number of hours or a number of days;
use the smallest practical unit that you
can record as a whole number.
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Apply the same units as used for the
'Allocated Time' and 'Time Expended'
fields.

Allocated Time

Type in the number of time units the task
can be spread over. (The value must be
an integer, so you cannot record part
units.)

The unit of time you adopt is by
agreement within the project, and
depends on the granularity of the work
being recorded. Most tasks are completed
in a number of hours or a number of days;
use the smallest practical unit that you
can record as a whole number.

Apply the same units as used for the
'Expected Time' and 'Time Expended'
fields.

Complete %

If the task is already in progress, type in
the current percentage completion.

Time Expended

(When the task is eventually 100%
complete, you will type in the number of
time units it actually took. The value
must be an integer, so you cannot record
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part units.)

The unit of time you adopt is by
agreement within the project, and
depends on the granularity of the work
being recorded. Most tasks are completed
in a number of hours or a number of days;
use the smallest practical unit that you
can record as a whole number.

Apply the same units as used for the
'Expected Time' and 'Allocated Time'
fields.

Start Date

This field defaults to today's date.
If you want to assign a different start date
for the task:

Click on the drop-down arrow.1.
If necessary, click on the Left or Right2.
Arrow to select the previous or next
month.
Click on the appropriate day of the3.
month as the start date.

The field immediately changes to the
selected date.

End Date

This field defaults to today's date.
If you want to assign a different end date
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for the task:
Click on the drop-down arrow.1.
If necessary, click on the Right Arrow2.
to select the next month.
Click on the appropriate day of the3.
month as the end date.

The field immediately changes to the
selected date.

Notes

In the Corporate, Unified and Ultimate Editions of·

Enterprise Architect, if User Security is enabled, you must
have 'Manage Project Settings' permission to perform
Resource Allocation

If you allocate resources to Use Cases, the information·

you enter contributes to the Use Case Estimation
calculation for estimating the project size in terms of time,
resources and cost

To edit existing Resource Allocation items for this·

element, display the allocation in the 'Assigned Resources'
dialog by either:
     -  Clicking on the 'Construct > Resource Management
> Resources' ribbon option, right-clicking on the required
item in the Resource
        Allocation window and selecting the 'Modify
Selected' option
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     -  Double-clicking on the item in the Resources list in
the 'Details' tab of the Inspector window   or
     -  Clicking on the item in the 'Element View' tab of the
Project Gantt Chart

You can also edit an existing Resource Allocation using·

the Properties window for that selected item; the fields
behave in the same way as those described in this topic

To delete existing Resource Allocation items for an·

element, click on the item in the Resource Allocation
window and click on  in the window toolbar
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Assign Multiple Resources
When you have a large unit of work associated with an
element - such as a Package element - you might want to
assign several resources to that element to perform that unit
of work. You can assign each person individually, but if the
resources have the same role or task you can assign all of
them together in one operation, using the 'Assigned
Resources' dialog.

This dialog is also used to edit Resource Allocations entered
previously through either the same dialog or the Resource
Allocation window.

Access

First, select an element, then:
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Ribbon Construct > Resource Management >
Gantt > Element View > right-click on
element > Assign Resource

Other On the Resource Allocation window,
right-click on a resource assignment and
click on the 'Modify Selected' option

Assign Multiple Resources to an Element

Option Action

Resource (To assign a single resource, simply type
in the name or click on the drop-down
arrow and select the name from the list.
In Project Management, it is simpler to
assign single resources directly through
the Resource Allocation window.)
For multiple resources, on the 'Assigned
Resources' dialog, click on the  button
on the 'Resource' field to display the
'Assign Resource' dialog.

Select the checkbox against each1.
resource to assign to the element; to
select all resources listed, click on the
Select All button.
Click on the OK button to close the2.

(c) Sparx Systems 2025 Page  21 of 109



Tasks & Resources 2 September, 2025

dialog and to add the selected resources
to the 'Resource' field.

The 'Resource' field now shows the
selected resources, but grayed out. The
drop-down arrow also is not active. To
change the resources in the field, click on
the  button again and select/clear the
appropriate checkboxes.

Role or Task Either:
Type in the role name or task that is·

common to all the selected resources,
or
Click on the drop-down arrow and·

click on the role that is common to all
the resources

Description Type (and, if you prefer, format) a
description of the work being done by the
resources.

History As the task progresses, you add text to
this tab to record the activities, progress,
problems and outcomes of the task.

Start Date This field defaults to today's date.
If you want to assign a different start date
for the task:
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Click on the drop-down arrow.1.
If necessary, click on the Left or Right2.
Arrow to select the previous or next
month.
Click on the appropriate day of the3.
month as the start date.

The field immediately changes to the
selected date.

Expected
Time

Type in the number of time units the task
is expected to take. (The value must be an
integer, so you cannot record part units.)
The unit of time you adopt is by
agreement within the project, and
depends on the granularity of the work
being recorded. Most tasks are completed
in a number of hours or a number of days;
use the smallest practical unit that you
can record as a whole number.
Apply the same units as used for the
'Allocated Time' and 'Time Expended'
fields.

Allocated
Time

Type in the number of time units the task
can be spread over. (The value must be
an integer, so you cannot record part
units.)
The unit of time you adopt is by
agreement within the project, and
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depends on the granularity of the work
being recorded. Most tasks are completed
in a number of hours or a number of days;
use the smallest practical unit that you
can record as a whole number.
Apply the same units as used for the
'Expected Time' and 'Time Expended'
fields.

End Date This field defaults to today's date.
If you want to assign a different end date
for the task:

Click on the drop-down arrow.1.
If necessary, click on the Right Arrow2.
to select the next month.
Click on the appropriate day of the3.
month as the end date.

The field immediately changes to the
selected date.

Complete % If the task is already in progress, type in
the current percentage completion.

Time
Expended

(When the task is eventually 100%
complete, you will type in the number of
time units it actually took. The value
must be an integer, so you cannot record
part units.)
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The unit of time you adopt is by
agreement within the project, and
depends on the granularity of the work
being recorded. Most tasks are completed
in a number of hours or a number of days;
use the smallest practical unit that you
can record as a whole number.
Apply the same units as used for the
'Expected Time' and 'Allocated Time'
fields.

Milestone This checkbox and drop-down list allow
linking the end date to the date of a
Milestone element that is no more than
seven days old.
(Milestone elements form part of the
structures developed using the Project
Management Technology, which you can
activate by selecting the 'Start > All
Windows > Perspective > Construct >
Project Management' ribbon option.)
Click on the checkbox to activate the
field, then click on the drop-down arrow
and select the Milestone element from the
list.

Previous Click on this button to display the
previous resource record in the sequence.
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Next Click on this button to display the next
resource record in the sequence.

New Click on this button to clear the fields on
the dialog so that you can define a new
resource allocation.

Apply Click on this button to apply the changes
to the currently-displayed element on a
diagram, without closing the dialog.

OK Click on this button to save the data you
have entered, and close the dialog.

Close Click on this button to discard the data
you have entered, and close the dialog.

Help Click on this button to display this Help
topic.

Notes

When the resource details are displayed on the Project·

Gantt Chart or Resource Allocation window, each
resource has their own record containing, initially, the
same data; however, each resource can be monitored and
their progress recorded separately
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If you assign resources that are already in a multiple·

resource assignment to the selected element, a prompt
displays for you to confirm that you are updating the
assignment of that resource, or now omitting that resource
from the existing assignment
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Effort Management
In Enterprise Architect, the Project Manager can allocate
effort (as time) to work on a given model element. To select
the element to which to allocate effort, click on the required
element in the Browser window or a diagram.

Access

Ribbon Construct > Project Management > Effort
: right-click | Add New

Keyboard
Shortcuts

Select an Effort item on a diagram or on
the 'Details' tab of the Inspector window,
then press Shift+Enter

Enter effort allocation details for an element

Effort

Type the name or a brief description of
the effort.

Type

Type in the effort type or click on the
drop-down arrow and select the type. The
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selection list is drawn from the global
Effort Type list, but any new efforts you
type in this field are not added to the list.

Time

Type in the amount of time the effort is
expected to expend.

Notes

Type in any additional notes or
description of this effort.

 OK

Click on this icon to save the data you
have entered and to add the entry to the
'Effort' list in the Effort window and the
'Details' tab of the Inspector window, and
close the dialog.

Cancel

Click on this button to discard the data
you have entered, and close the dialog.

Notes

To edit existing Effort items for this element, display the·

record in the Project Tools window by either:
     -  Clicking on the 'Construct > Project Management >
Effort' ribbon option and on the required item in the
'Effort' tab of the window, or
     -  Double-clicking on the item in the Project > Effort
list in the 'Details' tab of the Inspector window
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To delete existing Effort items for an element, right-click·

on the item in the 'Effort' tab of the Project Tools window
and click on the 'Delete' option

Although Enterprise Architect does not currently provide·

detailed reports on effort within a model, you can use the
Automation Interface or similar tools to create your own
custom reports based on effort information you enter
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Risk Management
In Enterprise Architect, the Project Manager can allocate the
possible weighting of defined risks that might impact work
on a given model element.

To select the element to which to allocate risk weightings,
click on that element in the Browser window or a diagram.

Access

Ribbon Construct > Project Management > Risks:
right-click | Add New

Keyboard
shortcut

Select a risk item on a diagram or
Element tab of the browser then use
Shift+Enter

Enter risk details for an element

Risk

Type the name or a brief description of
the risk.

Type

Type in the risk type or click on the
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drop-down arrow and select the type.
The selection list is drawn from the
global Risk Type list, but any new risks
you type in this field are not added to the
list. If there are no global risk types
defined, the drop-down arrow is not
displayed.

Weight

Defaults to the weighting for the defined
type. You can change this weighting if
necessary.

Notes

Type in any additional notes or
description of this risk. You can use the
Notes Toolbar at the top of the field to
format the text, if you prefer.

 OK

Click on this icon to save the data you
have entered and to add the entry to the
Risk list in the Risk window and the
'Details' tab of the Inspector window, and
close the dialog.

Cancel

Click on this button to discard the data
you have entered, and close the dialog.

Notes
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The risks described here are not the same as those·

represented by Risk elements; the risks are properties of a
single element, whilst the Risk element represents
something that can impact a range of other elements

If you select a global risk type from the 'Type' drop-down·

list and the associated 'Weight' field is empty, the default
Weight value is allocated to the 'Weight' field on the
'Risks' tab

To edit existing Risk items for this element, display the·

record in the 'Risks' dialog by either:
     -  Clicking on the 'Construct > Project Management >
Risks' ribbon option and on the required item in the 'Risks'
tab of the Project Tools window, or
     -  Double-clicking on the item in the Project > Risk list
in the 'Details' tab of the Inspector window

To delete existing Risk items for an element, right-click·

on the item in the 'Risk' tab of the Project Tools window
and click on the 'Delete' option

Although Enterprise Architect does not currently provide·

detailed reports on risks within a model, you can use the
Automation Interface or similar tools to create your own
custom reports based on risk information you enter
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Metrics
The Project Manager can allocate the possible weighting of
defined metrics to work on a given model element.

To select the element to which to allocate a metric
weighting, click on the required element in the Browser
window.

Access

Ribbon Construct > Project Management >
Metrics : right-click | Add New

Keyboard
shortcut

Select a metric item on a diagram or the
'Details' tab of the Inspector window, and
press Shift+Enter

Enter metric details for an element

Field/Icon Description
Metric

Type the name or a brief description of
the metric.

Type

Type in the metric type or click on the
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drop-down arrow and select the type.
The selection list is drawn from the
global Metric Type list, but any new
metrics you type in this field are not
added to the list. If there are no global
metric types defined, the drop-down
arrow is not displayed.

Weight

Defaults to the weighting for the defined
type. You can change this weighting if
necessary.

Notes

Type in any additional notes or
description of this metric.
You can use the Notes Toolbar at the top
of the field to format the text, if you
prefer.

 OK

Click on this button to save the data you
have entered and to add the entry to the
'Metrics' list in the Metrics window and
the 'Details' tab of the Inspector window,
and close the dialog.

Cancel

Click on this button to discard the data
you have entered, and close the dialog.
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Notes

If you select a global metric type from the 'Type'·

drop-down list and the associated 'Weight' field is empty,
you can allocate the default Weight value in the 'Weight'
field in the 'Metrics' dialog

To edit existing Metric items for this element, display the·

record in the 'Metrics' dialog by either:
     -  Clicking on the 'Construct > Project Management >
Metric' ribbon option and on the required item in the
Project Tools window, or
     -  Double-clicking on the item in the Project > Metrics
list in the 'Details' tab of the Inspector window

To delete existing Metric items for an element, right-click·

on the item in the Project Tools window or the 'Details'
tab and select the 'Delete' option

Although Enterprise Architect does not currently provide·

detailed reports on metrics within a model, you can use
the Automation Interface or similar tools to create your
own custom reports based on metric information you enter
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Show Project Items in a Diagram
When you have created a Project item (Decision, Event,
Effort, Risk, Metric), it is useful to make the record visible
on its parent element. You can do this by displaying the
record within a 'Project' compartment on the element as it
displays in a diagram. Any element that is capable of
displaying a compartment, and that has Project items
assigned to it, can show the items in a diagram.

Note that:

An Event records the action taken for the current model·

element

A Decision records the choice taken for the current model·

element

Show Project Items in Project Compartment

Step Action

1 Open a diagram containing the element
for which Project Items exist.

2 Double-click on the diagram background
to display the diagram properties dialog.
Click on the 'Elements' tab.

3 In the 'Show Compartments' panel, click
on the 'Project' checkbox.
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4 Click on the OK button.
Each Project Item now appears in the
Project compartment of the element on
the diagram. Items of each type are
grouped together so that, for example, all
Effort items on the element are grouped
under the heading 'Effort', and all Risk
items on the element are grouped under
the heading 'Risk'.
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Effort Types
When setting up the project management parameters for
monitoring work on elements, you can create types of effort
to add to the global list of effort types that can be assigned
to any element in the model. You can also select and edit
existing effort types. The global list of effort types displays
in the 'Type' drop-down list on the 'Effort' page of the
Project Indicators window.

Access

Open the 'Project Indicators' dialog using one of the
methods outlined here, then select the 'Effort' tab.

Ribbon Settings > Reference Data > Model Types
> Project Indicators : Effort

Keyboard
shortcut

Select an Effort item on a diagram or the
'Details' tab of the Inspector window,
then press Shift+Enter

Add a new effort type to the global list

Click the 'New' button to define a new Effort type

Option Action
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Effort Type the name of the effort type. (Or, to
edit an existing effort type, click on the
effort name in the Defined Effort Types
panel.)

Description Type a short description of the effort
type.

Weight Type the default weighting to apply to the
effort type.

<note> Type any additional information on the
effort type.

Save Click on this button to save the changes
that you have made to the dialog.

New Click on this button to clear the data
fields ready to define a new effort type.

Delete Click on an entry in the Defined Effort
Types panel, and click on this button to
immediately delete the effort type.

Close Click on this button to close the 'Project
Indicators' dialog. If you have not saved
your changes, the system prompts you to
save or abort those changes.

(c) Sparx Systems 2025 Page  40 of 109



Tasks & Resources 2 September, 2025

Notes

Although Enterprise Architect does not currently provide·

detailed reports on effort within a model, you can use the
Automation Interface or similar tools to create your own
custom reports based on effort information you enter

You can transport effort types between models, using the·

'Settings > Model > Transfer > Export Reference Data'
and 'Import Reference Data' ribbon options
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Metric Types
Enterprise Architect enables you to add a metric type to the
global list of metric types that can be assigned to any
element in the model. The global list of metric types
displays in the 'Type' field drop-down list on the Metrics
window.

Access

Open the 'Project Indicators' dialog using one of the
methods outlined here, then select the 'Metric' tab.

Ribbon Settings > Reference Data > Model Types
> Project Indicators : Metric

Add a new metric type to the global list

Click the 'New' button to define a new Metric

Option Action

Metric Type Type the name of the metric type. (Or, to
edit an existing metric type, click on the
metric name in the Defined Metrics
panel.)

Description Type a short description of the metric
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type.

Weight Type the default weighting to apply to the
metric type.

<note> Type any additional information on the
metric type.

Save Click on this button to save the changes
that you have made to the dialog.

New Click on this button to clear the data
fields ready to define a new metric type.

Delete Click on an entry in the Defined Metrics
panel, and click on this button to
immediately delete the metric type.

Close Click on this button to close the 'Project
Indicators' dialog. If you have not saved
your changes, the system prompts you to
save or abort those changes.

Notes

Although Enterprise Architect does not currently provide·

detailed reports on metrics within a model, you can use
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the Automation Interface or similar tools to create your
own custom reports based on metric information you enter

You can transport metric types between models, using the·

'Settings > Model > Transfer > Export Reference Data'
and 'Import Reference Data' ribbon options
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Risk Types
Using Enterprise Architect you can add a risk type to the
global list of risk types that can be assigned to any element
in the model. The global list of risk types displays in the
'Type' field drop-down list on the 'Risks' page of the Project
Indicators window.

Access

Open the Project Indicators window using one of the
methods outlined here, then select the 'Risk' page.

Ribbon Settings > Reference Data > Model Types
> Project Indicators : Risk

Add a new risk type to the global list

Click on the New button to define a new Risk

Option Action

Risk Type Type the name of the risk type. (Or, to
edit an existing risk type, click on the risk
name in the 'Defined Risks' panel.)

Description Type a short description of the risk type.
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Weight Type the default weighting to apply to the
risk type.

<note> Type any additional information on the
risk type.

Save Click on this button to save the changes
that you have made to the dialog.

New Click on this button to clear the data
fields ready to define a new risk type.

Delete Click on an entry in the 'Defined Risks'
panel, and click on this button to
immediately delete the risk type.

Close Click on this button to close the 'Project
Indicators' dialog. If you have not saved
your changes, the system prompts you to
save or abort those changes.

Notes

Although Enterprise Architect does not currently provide·

detailed reports on risks within a model, you can use the
Automation Interface or similar tools to create your own
custom reports based on risk information you enter
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You can transport risk types between models, using the·

'Settings > Model > Transfer > Export Reference Data'
and 'Import Reference Data' ribbon options
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Project Task Allocation
Using the Project Gantt View, you can review the allocation
of work to elements in the project, focusing on either the
elements that require work, or the resources required to
perform the work. The view primarily shows information
that is entered through other windows and dialogs, but once
a record exists in the view you can edit it and, for example,
add to or change the resources on an element.

Access

Ribbon Construct > Resource Management >
Gantt
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The Project Gantt View
In Enterprise Architect, you can visualize elements and
assigned project resources in a Gantt Chart format, to review
the breakdown of work for a specific project and for specific
sections of the project. The Project Gantt View illustrates a
project schedule by showing the start and finish dates of
assigned resources, so that a Project Manager can quickly
see the current project status using the percent-complete bar
shading and the percent-complete, resource name and status
columns. Information can be filtered, and overdue items can
quickly be highlighted and identified.

You can also access specialized versions of the Project
Gantt View from diagrams, Packages and the Personal
Tasks list.

Access

Ribbon Construct > Resource Management >
Gantt > Project Gantt View

Project Gantt View

This example shows four resources, two of whom are
working in different capacities on one task, and two on
another task. The resource names and roles are listed in the
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left panel of the chart, together with the actual percentage
completion of each person's work on the task. In the right
panel of the chart, completed work is indicated by the green
section of the bar, work yet to be completed but not yet due
is indicated in blue, and work not completed and overdue is
indicated in red (as a result of the option to highlight
overdue work being applied).

Tabs of the Project Gantt View

The Project Gantt View has three tabs, the first two of which
use the Gantt chart itself to show the progress of work
against the resources performing the work or the elements
having the work performed on them. (Other variations of the
Gantt chart do not have these separate tabs.)

View Detail

Resource
View

When you initially open the Project Gantt
View, it defaults to the 'Resource View'
tab, in which the focus is on the current
commitments of each allocated resource
in the project.
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Element
View

The Element View lists the elements in
the project that have resources assigned
to them, and the resources assigned to
each element.

Report View A Resource report shows how your
resources are deployed in your project,
displaying a list of all elements that have
resources allocated to them.

Project Gantt View Facilities

The facilities of the Project Gantt View are common to the
Resource and Element Views, and in some cases to all three
tabs, as described here.

Option Action

Display tasks
for today
only, or for
another day
only

Right-click on the display and select the
option:

'Show Only Active Tasks for Today' -·

to show only tasks that are in progress
today
'Show Only Active Tasks for Other·

Day' - to show only tasks that were in
progress on a specific day in the past,
or that are scheduled to be in progress
on a day in the future; a calendar dialog
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displays from which you select the day
to examine

Display the
properties of
the element
to which a
resource is
assigned

Right-click on the element entry and
select the 'Show Element Properties'
option.
The 'Properties' dialog for the element
displays.

Display the
Resource
Allocation
details for an
element or
resource

Right-click on the entry and select the
'Show Task Properties' option.
The 'Assigned Resources' dialog displays;
you can edit the details and, if necessary,
change the resource allocated to the
element.

Display the
Resource
Allocation
records for an
element

(Also available in the Report View.)
Right-click on the entry and select either
of the context menu options:

'Show Element Resource Allocation·

window' (if the window is closed or
hidden)
'Find Task in Element Resource·

Allocation window' (if the window is
visible but showing the details of
another element)

The Resource Allocation window
displays, with the details of the selected
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entry shown in the fields and the other
resource allocations for the element listed
in the left-hand panel.
You can edit the details and, if necessary,
change the resource allocated to the
element.

Assign a new
resource to
an element

Right-click on an element in the display,
and select the 'Assign Resource' option.
The 'Assigned Resources' dialog displays;
complete this as for the Resource
Allocation window.

Change the
scale of the
display

By default, the Project Gantt View shows
periods of time in units of days of the
month, each date column being
approximately one centimetre wide.
Weekends have a darker fill color.
You can change the scale of the date
columns by clicking on the column
header, pressing Ctrl and rolling the
mouse wheel. As you do this:

At one extreme the date columns·

expand to approximately 2.5
centimetres, and the date header shows
the full date in dd/mm/yyyy format
Rolling to the other extreme changes·

the scale of the column from date
through week, labeled month,
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numbered month and labeled year to
numbered segments of a decade

This allows you to represent a wide range
of tasks on a single chart and to condense
or expand the view - in conjunction with
filters - to investigate the short term and
longer term work clearly.

Change the
duration of a
task, on the
Project Gantt
View

You might want to make broad
adjustments to the timeline of an event,
which you can easily do on the Project
Gantt View itself. For example, the
resource is ill, or another resource has
taken over other tasks that the resource
was allocated to. In neither case has the
task itself changed, but in the first case
the resource needs a longer elapsed time
in which to complete the task, and in the
second they have less other work to do
and can finish the task sooner.
To make these adjustments, you simply
drag the right end of the time bar further
or back along the chart. This changes the
task end date to wherever you drag the
time line to, and adjusts the division into
complete and incomplete/overdue work
to maintain the percentage completion
value. The work time allocated to the task
does not change.
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If you drag the left end of the time line,
this moves the whole line without
changing its length or proportions; you
are just indicating that the task started
earlier or later and will finish earlier or
later by the same amount of time.

Grouped
work

A resource is likely to be allocated to
several tasks either simultaneously or
consecutively. In the Resource View the
tasks assigned to a resource are grouped
under the resource name, and a narrow
group bar displays in gray on the chart
against the name, spanning the period
from when work is scheduled to begin on
the first task to when work is scheduled
to finish on the final task.
Similarly, a body of work, represented by
an element, might involve several
resources starting and finishing at
different points. The resources are
grouped under the element name and the
group bar displays on the chart against
the element name, spanning the period
from when the first resource is scheduled
to start work to when the last resource is
scheduled to complete work on the task.
If any adjustments are made that impact
the initial start point or final completion
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point of the work, the end of the group
bar automatically adjusts. If any task or
resource in the group is overdue, the
group bar turns red to reflect that there is
a potential problem in the allocated work.

Filter the
display to
exclude
elements by
status

(This feature takes effect under your user
ID.)
Right-click on the window and select the
'Apply Element Status Filter' option.
The 'Excluded Status Types' dialog
displays; select the checkbox against one
or more statuses to exclude elements
having those statuses from the list.
You can select every checkbox at once by
clicking on the Select All button, and
clear all selections by clicking on the
Clear All button.
Click on the OK button to immediately
apply the filter, which stays in effect until
you specifically change it.

Filter the
display to
include
elements
having
certain
properties

Right-click on the list and select the
'Show Filter Bar' option.
The Filter Bar displays underneath the
heading bar. Type a text string in the field
above a column to immediately filter the
list for entries that have the text string in
the values in that column.
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To delete a filter string altogether, click
on the blue cross at the right of the field.
If you no longer want to use the filter bar,
right-click on the list and select the 'Hide
Filter Bar' option.

Filter the
display by
Start or
Completion
date

The display default is to show current
tasks for which the end date has not yet
occurred. Right-click on the list and
select one of the options:

'Include Completed Tasks Within the·

Last ...' - to display incomplete tasks
and tasks completed only within the
specified period; you can set this period
to 7, 30 or 90 days, or you can include
all completed tasks, or hide all
completed tasks
'Include Future Tasks Starting in ...' - to·

display current incomplete tasks and
completed tasks (depending on the
setting of the 'Include Completed Tasks
Within the Last ...' option) and future
tasks that have been recorded and are
due to start within the next period; you
can set this period to 7, 30 or 90 days,
or you can show all tasks that have
been recorded but are not yet due to
start
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Identify
overdue tasks

Right-click on the display and select the
'Display Highlight For Overdue items'
option and one of its sub-options:

'Show in Red' - to display the·

uncompleted percentage of the task
bars for overdue items on the Gantt
chart in red
'Show in Red to Current Date' - to·

extend the task bars of the overdue
items to today's date, and display them
in red
'None' - to cancel any overdue item·

highlighting that has been set

Display
ONLY
overdue tasks

Right-click on the display and select the
'Show Overdue Items Only' option.
The display shows only those items for
which the end date has passed but that are
not 100% complete. These items do not
have red highlighting.

Refresh the
report

Right-click on the entry and select the
'Refresh' option.
The content of the display is refreshed
and collapsed to element or resource
level.

Reposition
the Project

Right-click on the display and select the
'Go to | Auto Sync with Task End Date'
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Gantt View
to
automatically
show the end
date of a
selected
allocation

option.
Whilst this option is selected (with a tick
next to it), whenever you click on an
allocation the display adjusts to show the
end date of the task in the center of the
chart.

Reposition
the Project
Gantt View
to show the
start date or
end date of
an allocation,
or today's
date

Right-click on the entry and select the
required option:

Go To | Task Start Date·

Go To | Task End Date·

Go To | Today's Date·

The display shifts to put the required date
in the center of the chart.

Locate the
element in
the Browser
window

(Also available in the Report View.)
Right-click on the element name and
select the 'Find in Project Browser'
option.
The area of the Browser window
containing the element is brought into
focus and expanded, and the element is
highlighted.

Send a Model
Mail to the

It is possible to send a Model Mail
directly from the Project Gantt View to a
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resource selected resource if the resource's Author
name matches their:

Enterprise Architect security user ID·

(Security has been enabled) or
Their workstation login ID (Security·

has not been enabled)
Right-click on the resource or one of their
activities and select the 'Post Model
Message' option. This opens a Model
Mail message addressed to the resource,
for you to complete and send.

Save an
image of the
Project Gantt
View to file

Right-click on the tab and select the 'Save
Image to File' option.
The 'Save As Image' dialog displays, on
which you specify the file name, location
and graphics file type to save to.

Save an
image of the
Project Gantt
View to the
clipboard

Right-click on the tab and select the
'Copy Image to Clipboard' option.
You can paste the image from the
clipboard into your preferred graphics
application.

Notes

Items in the list pane can be filtered; right-click on the·
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column headings in the list pane to toggle the Filter Bar
between hidden or shown, or to edit the filter
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Resource View
The 'Resource View' tab shows the current commitments of
each allocated resource in the project as a list of allocation
records and a Gantt chart of the progress of the allocations.

The display initially shows the resources and their overall
commitment; click on the 'plus-box' to the left of the name
of the resource to expand the entry to show the elements and
the allocation period for each element.

The display shows both complete allocations and those that
are still in progress; an internal filter hides completed
allocations two weeks after the end date, and incomplete
allocations one month after the end date. Tasks you can
perform include checking the:

Dates on which specific resources or all resources are·

currently allocated

Elements to which each resource is allocated·

Dates on which a resource is allocated to work on a·

specific element

General progress of the resource in completing the work·

Specific details of the allocation of a resource to an·

element and task or role

Access

Ribbon Construct > Resource Management >
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Gantt : Select the 'Resource View' tab
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Element View
The 'Element View' tab of the Project Gantt View lists the
elements in the project that have resources assigned to them.
It shows the resources assigned to each element as a list of
allocation records and as a Gantt chart of the progress of the
allocations. An allocation can be partial, in that a role or
task is assigned but no specific resource has been identified.

The display initially shows the elements and their overall
resource commitment; click on the 'plus-box' to the left of
the name of the element to expand the entry to show the
resources and the allocation period for each resource. You
can then:

Check the dates on which specific elements have·

resources currently allocated

Check which resources are currently allocated to an·

element

Assign further resources to the element·

Check the dates on which a resource is allocated to work·

on a specific element

Check the general progress of the resource in completing·

the work

Check the specific details of the allocation of a resource to·

an element and task or role

The display shows both complete allocations and those that
are still in progress; an internal filter hides completed
allocations two weeks after the end date.
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The 'Element View' complements the 'Resource View' and
'Personal Tasks View' of work allocation on the project.

Access

Ribbon Construct > Resource Management >
Gantt    or
Design > Diagram > Views > Gantt View

Context
Menu

Browser window | right-click on an open
diagram | Switch View | Switch to Gantt
View
In diagram, right-click on background |
Switch View | Switch to Gantt View
Browser window | Right-click on
Package | Open Package in | Gantt View
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Report View
The Report View shows how your resources are deployed in
your project, displaying:

A list of all elements that have resources allocated to·

them, and the type of each element

The resource allocated, and the role played by that·

resource

The start and end dates of the allocation·

The time allocated, expected and expended·

The percentage completion of the allocation·

You can tailor the displayed information by:

Hiding columns of information·

Grouping types of information·

Filtering the data by status·

Filtering the data by start date or end date·

Filtering any column to show only a specific value·

Having displayed the information you require, you can print
it.

Access

Ribbon Construct > Resource Management >
Gantt : Select the 'Report View' tab
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Report View Options

Option Action

Run the
report

Click on the first icon in the Report View
toolbar (the rotating arrows).
The report results display.
If you have the report open for a while,
you can update the information; either:

Run the report again or·

Right-click on the content and select·

the 'Refresh' option

Adjust
column
headings

Drag and drop column headings into the
sequence you require.
Right-click on the column headings and
select the 'Field Chooser' option, to add
or remove columns using the 'Field
Chooser' dialog.

Group entries
by column
heading

Right-click on the column headings and
select the 'Enable Group Box' option, to
cluster the report information according
to your preferred hierarchy of column
headings.
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Filter
columns

Either:
Click on the third toolbar icon from the·

right (the spy glass), or
Right-click on the column headings·

and select the 'Toggle Filter Bar' option
The filter field displays at the top of
every column.
Type in whatever text string you require
in the appropriate column to filter the
report to show only entries containing
that text string in that column.

Filter by
degree of
completion

In the first field in the toolbar, click on
the drop-down arrow and select one of
these values:

'All' - Display all entries regardless of·

degree of completion
'Completed' - Display only those·

entries where the allocation is 100%
completed
'Above cut-off' - Display only those·

entries that are more than a certain
percentage complete
'Below cut-off' - Display only those·

entries that are less than a certain
percentage complete

In the second field in the toolbar, either
type a threshold value or increment to the
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value using the up/down arrows, to set
the percentage completion for the
'Above/Below cut-off' options.

Filter
according to
start/end date

Click on the fourth toolbar icon from the
right (the funnel).
The 'Resource Filters' dialog displays.
In the 'Start Date' and/or 'End Date' field,
click on the drop-down arrow and select
the appropriate qualifier:

'After'·

'Before'·

'Equal To'·

'Not Equals'·

In the date fields, click on the checkbox
to activate the fields and either type in the
day, month and year or click on the
drop-down arrow to select the date from a
calendar.
The fields have an AND relationship; an
entry must satisfy both date criteria
before it is displayed.

Print the
report

Either:
Click on the second toolbar icon from·

the right (the printer) or
Right-click on an entry in the report·

and select the 'Print' option
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The 'Print' dialog displays, on which you
specify the printer to use and the
characteristics of the print job.
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Progress Bars
Progress bars are horizontal bands that show the degree of
completion of a task or process. They give a quick
indication of the current status of, for example, projects,
tasks or budgets, which can be useful for checking how
close a task or project is to completion or if a project is
coming close to hitting its total allowed budget.

Progress bars can be especially useful in large projects that
consist of multiple smaller projects, as you can display
within one element separate bars showing the degree of
completion of each sub-project and of the main project,
giving you an overview of progress at a single glance.
Separate elements within the diagram can contain further
progress bars for the metrics of the individual projects,
adding levels of detail that can, again, be assessed in a brief
review.

In Enterprise Architect, progress bars are implemented using
Tagged Values on elements. They are automatically added
to elements on a Kanban diagram or Construction diagram,
where progress or resource consumption are indicated.
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Using Progress Bars
You can add progress bars to any element that can show
compartments and that can display any numerical value
within a range, when displayed on a diagram.

Progress bars can be used to display things such as:

The current progress of a task or project·

How much of project's budget has been used·

By default a progress bar will display a value between 0 and
100 (inclusive); however, it is possible to adjust both the
minimum and maximum values to set any range of values
required.

This illustration shows an example of a default progress bar:

Creating a Progress Bar using a new Tagged
Value

Follow the steps below to display a progress bar within an
element, using a simple Tagged Value.

Ste
p

Action

1 On a diagram, create an element that can display
compartments (such as a Requirement or Feature)
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and add a simple Tagged Value to it.

2 From the 'Tags' tab of the Properties window open
the tag's notes and add 'Type=ProgressBar;'
(including the semi-colon) and then click on the OK
button.

(You can add further options to the Tagged Value, as
described in the Additional Progress Bar Options
table.)

3 Click on the element and either press Ctrl+Shift+Y
or right-click and select the 'Compartment Visibility'
option. The 'Compartment Visibility' dialog displays.

4 Select the 'Tags' checkbox in the 'Show Element
Compartments' panel, then click on the OK button.
The progress bar will now display on the element on
the diagram, with the Tagged Value name above the
bar.
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5 In the 'Tags' tab of the Properties window, indicate
progress by typing a number between 1 and 100 into
the 'Value' field for the tag. On the diagram, the
appropriate length of the progress bar is filled in
green.

Creating a Progress Bar from the 'UML
Types' dialog

You can also define a progress bar Tagged Value from the
'UML Types' dialog that can then be applied to any element,
without having to set the Tagged Value notes each time.

Ste
p

Action

1 Select the 'Settings > Reference Data > UML Types'
ribbon option to display the 'UML Types' dialog and
click on the 'Tagged Value Types' tab.

2 In the 'Tag Name' and 'Description' fields, type a
name and description for the Tagged Value. In the
'Detail' field type the option parameters and their
values for the Tagged Value. Click on the Save
button and on the Close button.
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(The option parameters are described in the
Additional Progress Bar Options table.)

3 Select the 'Start > Application > Design > Properties'
ribbon option to open the Properties window (if it is
not already open) and select the 'Tags' tab.
On a diagram select an element, then on the 'Tags'
tab click on the  (New Tagged Value) button.
In the 'Tag' field of the Tagged Value dialog, click
on the drop-down arrow and select the Tagged Value
you created in step 2, then click on the OK button.

4 On the diagram, right-click on the element and select
the 'Compartment Visibility' option to display the
'Compartment Visibility' dialog.
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5 Select the 'Tags' checkbox and click on the OK
button.

6 On the 'Tags' tab, change the number in the value
field a few times, clicking off the field each time.
Notice the effect this has on the progress bar.

Creating a Progress Bar using the Custom
Drawn Element

Custom-drawn elements allow the use of the element's fill
color to represent the progress in the progress bar, so the
element itself becomes the progress bar.
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To display progress using the element's fill color as the
progress bar, setup a Tagged Value for the progress bar as
described in the previous sections, then add the following
line to the Tagged Value's Notes: FillElement =true;  You
will also need to set the Diagram property "Appearance >
Custom Style", by placing a check against that property.

You can set the fill color, background color and border
color, by adding further parameters to the Notes of the
Tagged Value.

For example:

FillClr=val;·

BackClr=val;·

BorderClr=val;·

When setting the colours of a progress bar, 'val' can be
supplied in a variety of ways, such as:

RGB(0,128,0);·

HSL(300, 50,86);·

#00FF00;·

Default web colour names such as AliceBlue, Green or
Khaki can also be used. Additionally, it is possible to use
the current fill, line, or text color of the element for the
properties mentioned above by using ‘elementfill’,
‘elementborder’, or ‘elementtext’.

For example:

FillClr=elementfill;·

BorderClr=elementtext;·
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Examples of Setting Colors When Displaying
Progress Using Element Fill Color

Example Tagged Value Note

Using Hex
Values

Type=ProgressBar;
FillElement=true;
FillClr=#2F4550;
BorderClr=#629677;
BackClr=#586F7C;

Using  HSL,
RGB and
Default
HTML
Colors

Type=ProgressBar;
FillElement=true;
FillClr=hsl(210,100,97);
BorderClr=RGB(23,12,202);
BackClr=LightSeaGreen;

Using RGB
and Current
Element Fill
and Border
colors

Type=ProgressBar;
FillElement=true;
FillClr=rgb(230,214,239);
BorderClr=elementline;
BackClr=elementfill;

Using the
current
element fill

Type=ProgressBar;
FillElement=true;
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FillClr=elementfill:s=-30:l=70:;
BorderClr=elementline;
BackClr=elementfill;

In this example the current element fill·

is used for both the fill color of the
progress bar as well as the background
color.  However, the fill color is
modified from the original element fill
to be less saturated (30% less) and
brighter (70% increased luminosity):

Additional Progress Bar Options

A default progress bar will show the Tagged Value name
and reflect values in the range 0-100. You can change the
range values if required, and display text to the right of the
bar if more information has to be provided. The background,
border and fill colors of the progress bar are, by default,
determined by the currently-applied inbuilt diagram theme.
However, you can apply your own colors to one of more of
these properties.

Add these parameters to the Notes field of the Tagged
Value, to enhance the progress bar.

Parameter Description

MinVal Use the MinVal option to set the lowest
allowed value to be represented on the
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progress bar.
Syntax: MinVal=<number>;·

A progress bar with the setting
MinVal=10; will start at 10. Values lower
than 10 will not be shown on it.
If a maximum value (MaxVal) has been
defined, the progress bar will show any
values between MinVal and MaxVal
(inclusive); otherwise, the maximum
value will default to MinVal + 100. So, if
MinVal=10, the progress bar can show
values between 10 and 110 (inclusive).

MaxVal Use the MaxVal option to set the highest
allowed value to be represented on the
progress bar.

Syntax: MaxVal=<number>;·

A progress bar with the setting
MaxVal=300; will show values up to and
including 300. Values higher than 300
will not be shown.
If a minimum value (MinVal) has been
set, the progress bar will show any values
between MinVal and MaxVal (inclusive);
otherwise the minimum value will default
to 0. So, if MaxVal=300 the progress bar
can show values between 0 and 300
(inclusive).
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Text Use the Text option to define additional
text to display on the right hand side of
the progress bar. The text might be a
resource name or the current take up of
the total allowed budget of a project.

Syntax: Text=<text>; - displays the·

defined text string, such as 'David
Brown's Tasks'
Syntax: Text=#Value#; - displays the·

value of the progress bar Tagged
Value, such as '462' (where the Tagged
Value name itself might indicate the
type of value or unit)
Syntax: Text=<text> #Value# <text>; -·

displays the value of the progress bar
Tagged Value with text before and/or
after it, such as '$<value> of $100,000'

This illustration shows a number of
examples of using the Text option.

Compartment By default, progress bars in an element
display together in a separate
compartment from other types of Tagged
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Value (provided that the diagram and/or
element is set to display tag
compartments).
When there are several progress bars on
an element, each relating to a different
factor of the project, it can become harder
to distinguish between them. In these
cases it is possible to set the progress bars
to display in specific compartments in
order to increase clarity. This also
provides an additional level of labeling.
So you might have an element relating to
costs, and two or more compartments that
indicate costs of different departments,
where the department name is reflected in
the compartment name. Or compartments
that each contain two or more progress
bars indicating, say, the costs and
percentage completion of tasks in each
department.

Syntax: Compartment=<name>;·

To add multiple progress bars to the same
compartment simply give the progress
bars the same compartment name.
This example shows the element from the
Text parameter example, but with the use
of compartments to aid in readability.
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BackClr Use the BackClr option to override the
color used for the unfilled portion of the
progress bar.

Syntax: BackClr=<color>;·

<color> can be one of a variety of values,
such as the RGB value rgb(198,198,198)
for a light gray color.
See the Progress Bar Color Options table
for a full list of available values when
setting colors.

FillClr Use the FillClr option to override the
color used for the filled portion of the
progress bar.

Syntax: FillClr=<color>;·

<color> can be one of a variety of
options, such as the hex value #0000ff for
a bright red.
See the Progress Bar Color Options table
for a full list of available values when
setting colors.
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BorderClr Use the BorderClr option to override the
color that is drawn around the edges of
the progress bar.

Syntax: BorderClr=<color>;·

<color> can be one of a variety of
options, such as the keyword elementtext
to select the same color as the current
element's text color.
See the Progress Bar Color Options table
for a full list of available values when
setting colors.

Example

The Requirement element 'REQ015 - Process Credit Card
Payment' is given a Tagged Value named 'Completion', with
a value of '66'.

In the Tagged Values Notes, we specify
'Type=ProgressBar;' along with display text and color
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settings.

The result is the Progress Bar seen here:

Progress Bar Color Options

This table lists the different types of value that can be used
with the options BackClr, FillClr and BorderClr when
setting custom colors for a progress bar.

Value Description
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rgb(red,green
,blue)

Using rgb values you can set the red,
green and blue color components to
create the color you require.
Example:
BackClr=rgb(46, 139, 87); //Sets the
unfilled portion of the progress bar to a
sea green color.

The red, green and blue values each·

have a range of 0 to 255
This option can be useful in conjunction
with the color pickers from the 'Layout'
tab as they give an RGB value for the
currently selected color.

hsl(hue,
saturation,
luminosity)

Using hsl is very similar to using rgb.
Unlike rgb, however, it is easier to create
a lighter or darker version of the same
color by simply adjusting the luminosity,
or to increase or decrease the intensity of
the color by adjusting the saturation.
Example:
FillClr=hsl(197, 71, 73); //Sets the filled
portion of the progress bar to a sky blue
color.

The hue value has a range of 0 to 360·

The saturation and luminosity values·

each have a range of 0 to 100
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Hex Values Colors can also be defined using a hex
value.
Example:
BorderClr:#000000; //Sets the border
color of the progress bar to black.

Hex values range from #000000 to·

#ffffff

HTML Color
Names

It is also possible to use the standard web
color names when defining a color for
progress bars.
Example:
fillclr=aliceblue; //Sets the filled portion
of the progress bar to the standard color
'aliceblue'

Enterprise Architect supports the 140·

standard HTML color names.

Element
Colors

Using ElementFill, ElementLine or
ElementText will set the color value to
the fill, line or text color of the
currently-selected element (that is,
ElementFill will apply the element's
current fill color).
Colors set this way can be further refined
by using the modifiers s=<value> and
l=<value> to modify the color's
saturation and luminosity, making the
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color assigned to the progress bar a
slightly altered version of the currently
selected element color.
These settings can be useful if the
element is expected to change color (such
as from the use of a Diagram Legend) to
keep the progress bars themed correctly
with the element.
Example:
backclr=elementfill:s=-10:l=20:;   //Sets
the unfilled portion of the progress bar to
be the same as the element's fill color but
with a 10% decrease in the color's
saturation and a 20% increase in the
luminosity.

s and l can be any value; however, the·

results can vary depending on the
currently selected color (for example, a
luminosity increase of 20% might not
be as noticeable on a very light color
compared to a darker color)

none The none keyword is used to indicate that
no color should be applied to the selected
field.
Example:
borderClr=none; //Removes the border
from the progress bar.
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Progress Bars with MDG Technologies

Progress bars can also be created within MDG Technologies
to define a consistent set of progress bars for use with
multiple projects.
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Personal Tasks
Using the Personal Tasks view, you can record and manage
your personal work within the project. This view displays
information based upon your identity as a defined Author on
the project.

Access

Ribbon Start > Personal > My Gantt

Work Category

Category Detail

Allocated
Work

Presents a Gantt chart on which you
record the work that you are currently
engaged in.

Project Tasks Enables you to monitor and maintain the
work tasks that have been assigned to
you, or that you have created yourself.
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Review Allocated Work
The 'Allocated Work' tab lists the elements to which your
model Author ID has been allocated as a resource, where
your Author ID is the same as:

Your Enterprise Architect security user ID, if security has·

been enabled, or

Your workstation login ID if security has not been·

enabled

For each element, the tab:

In the left-hand panel lists the roles or tasks assigned to·

you as a resource on that element, for which the
'Complete %' field value is less than '100'

In the right hand panel displays a Gantt chart showing·

your progress in performing each role or task

You can add further work items for an element through the
'Allocated Work' tab; however, you cannot delete any
records. A record is no longer listed when the 'Complete %'
field value is '100'.

You or your supervisors can also add records through the
Resource Allocation window.

Access

Ribbon Start > Personal > My Gantt > Allocated
Work
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Select Allocated Work options

Option Action

Review
element
properties

Double-click on the element name.
(Alternatively, right-click on the element
name and select the 'Show Element
Properties' option.)
The 'Properties' dialog for the element
displays; review the pages as required.

Review
resource task
details

Double-click on the task item.
(Alternatively, either:

Double-click on the progress bar for·

the item on the Gantt chart, or
Right-click on the task or role name·

and select the 'Show Task Properties'
option)

The 'Assigned Resources' dialog displays,
which has the same content, format and
functions as the Resource Allocation
window, in 'Item' mode.
Should it be necessary to reassign the
item to another resource, click on the
drop-down arrow on the 'Resource' field
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and select the appropriate 'Author ID';
when you save the changes, the item no
longer appears in the list of tasks
assigned to you.

Create new
task item

Right-click on the element name and
select the 'Add Resource' option.
The 'Assigned Resources' dialog displays,
with your Author ID in the grayed-out
'Resource' field.
Complete the dialog as for the Resource
Allocation window.

Refresh
display to
incorporate
changes

Your work item can be edited in a
number of places in Enterprise Architect,
such as the Project Task Allocation
window and the 'Resource Allocation'
tab; the element to which it is assigned
can be edited in these and many other
areas.
To refresh the display with any changes
made elsewhere, right-click on the
display and select the 'Refresh' option.

Display the
Resource
Allocation
records for
the element

Right-click on the entry and select either
of the options:

'Show Element Resource Allocation·

window' (if the window is closed or
hidden)
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'Find Task in Element Resource·

Allocation window' (if the window is
visible but showing the details of
another element)

The Resource Allocation window
displays, with the details of the selected
entry shown in the fields and the other
resource allocations for the element listed
in the left-hand panel.
You can edit the details and, if necessary,
change the resource allocated to the
element.

Display tasks
for today
only, or for
another day
only

Right-click on the display and select the
option:

'Show only Active tasks for today' - to·

show only tasks that are in progress
today
'Show only Active tasks for another·

day' - to show only tasks that were in
progress on a specific day in the past,
or that are scheduled to be in progress
on a day in the future; a calendar dialog
displays from which you select the day
to examine

Filter the
display by
Start or

The display default is to show current
tasks for which the end date has not  yet
occurred. Right-click on the list and
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Completion
date

select one of the options:
'Include Completed Tasks Within the·

Last ...' - to display incomplete tasks
and tasks completed only within the
last period; you can set this period to 7,
30 or 90 days, or you can include all
completed tasks, or hide all completed
tasks
'Include Future Tasks Starting in ...' - to·

display current incomplete tasks and
completed tasks (depending on the
setting of the 'Include Completed Tasks
Within the Last ...' option) and future
tasks that have been recorded and are
due to start within the next period; you
can set this period to 7, 30 or 90 days,
or you can show all tasks that have
been recorded but are not yet due to
start

Identify
overdue tasks
amongst the
items

Right-click on the display and select the
'Display Highlight For Overdue items'
option and one of its sub-options:

'Show in Red' - to display the·

uncompleted percentage of the task
bars for overdue items on the Gantt
chart in red
'Show in Red to Current Date' - to·

extend the task bars of the overdue
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items to today's date, and display them
in red
'None' - to cancel any overdue item·

highlighting that has been set

Display
ONLY
overdue tasks

Right-click on the display and select the
'Show Overdue Items Only' option.
The display shows only those items for
which the end date has passed but that are
not 100% complete. These items do not
have red highlighting.

Locate the
element in
the Browser
window

Right-click on either the element or the
work item and select the 'Find in Project
Browser' option.
The appropriate Package hierarchy
expands in the Browser window, and the
selected element is highlighted.

Reposition
the Gantt
chart to
automatically
show the end
date of a
selected
allocation

Right-click on the display and select the
'Go to | Auto Sync with Task End Date'
option.
Whilst this option is selected (with a tick
next to it), whenever you click on an
allocation in the 'Allocated Work' tab the
display adjusts to show the end date of
the task in the center of the chart.

Expose Some items might operate over a long
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hidden
sections of
the work item
progress

period of time, and you might not be able
to display the complete progress line for
the item in the Gantt chart.
To locate the start point, expected end
point, or today's date on the progress line
for an item, right-click on either the item
or the progress line and select the
appropriate option:

Go To | Task Start Date·

Go To | Task End Date·

Go To | Today's Date·

The Gantt chart shifts left or right to
position the required point in the center of
the display.

Execute
Scripts

If scripts have been defined for analyzing
the task data, click on the 'Scripts' option
to display the list of script names. Click
on the appropriate name to execute the
script on the selected item or items.

Filter the
work items

You can refine the list of work items to
show only those containing text that
matches the filter item.
Right-click on the tab and select the
'Show Filter Bar' option.
The filter bar displays at the top of the
panel; type in the filter text.
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As you type, the items listed and the
Gantt chart are filtered to show only
items where the item names match the
text string.
The filter does not operate on the element
names.
If you do not want to use the filter,
right-click on the tab and select the 'Hide
Filter Bar' option.

Capture an
image of the
Allocated
Work data as
a graphics
file

Right-click on the tab and select the 'Save
Image to File' option.
The 'Save As Image' dialog displays, on
which you specify the file name, location
and graphics file type to save to.

Copy an
image of the
Allocated
Work data to
the clipboard

Right-click on the tab and select the
'Copy Image to Clipboard' option.
You can paste the image from the
clipboard into your preferred graphics
application.
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Monitor Your Tasks
The 'Project Tasks' tab lists the tasks that you either:

Own, or·

Are assigned to·

You can use the tab to review the status and progress of
tasks that you are responsible for, and to modify and filter
the display of task information. You can create the tasks
through the:

'Project Tasks' tab of the My Gantt display itself·

The Project Management Project Tasks view (of all tasks·

in the project), or the

'Project Tasks view of the Resource Calendar·

Access

Ribbon Start > Personal > My Gantt > Project
Tasks

Make selections from the options

Option Action

Add or You add or modify a task through the
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Modify a task 'Task Detail' dialog, which displays when
you double-click on an entry (edit) or
blank line (create).

Delete a task Right-click on the message and select the
'Delete' option.
You are prompted to confirm the
deletion.

Select
columns

Right-click on the column headings and
select the 'Field Chooser' option, which
enables you to add or remove specific
columns from the display.
You can also click on the column
headings and drag them across the header
bar to reposition the columns in a
different sequence.

Reorganize
tasks in the
list

Either:
Click on the column heading and click·

on the arrow head to list items in order
or reverse order, or
Right-click on the column headings·

and select the 'Enable Group Box'
option to organize the messages into
groups

You can also use the filter bar to filter the
display on an appropriate column value,
such as the value 'New' in the 'Status'
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column; to display or hide the filter bar,
right-click on the column headings and
select the 'Toggle Filter Bar' option.

Set persistent
Status filter

Right-click on the tab and select the 'Set
term filter' option.
The 'Filter by Status' dialog displays,
which enables you to select to list tasks of
any status or only of one specific status.
The filter you set persists when you close
the Personal Tasks window or exit from
Enterprise Architect.

Print the task
list

Right-click on the tab and select the 'Print
List' option.
The 'Print' dialog displays, on which you
specify the local printer and the print
characteristics.
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Project Tools Window
The Project Tools window shows the records of these
quantities associated with an element contained in the
model:

Decision - a choice made on a requirement of the element·

Event - an action taken on a requirement of the element·

Issue - a failure of the element to meet a requirement·

Task - an item of work on the element assigned to a·

resource to meet a requirement

Effort - effort expended in work on the element·

Risks - risk associated with the element·

Metrics - metrics measured for an element·

A separate tab of the Project Tools window or - for Issues
and Tasks - report list displays for each of these quantities.

Access

Ribbon Construct > Project Management and as
required, one of:

> Events | Show Events Window·

> Decisions | Show Decisions Window·

> Issues-Tasks | Project Tasks·

> Issues-Tasks | Project Issues·

> Effort·
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> Risks·

> Metrics·

Keyboard
Shortcuts

Click on the required Project item on a
diagram or on the 'Details' tab of the
Inspector window, then press Shift+Enter

Context Menu Options

You can add or delete individual items in any of the tabs of
the Project Tools window, using the window context menu
options.

Icon Action

Add New Create a new Decision/Event item, using
the '<type> details for <element type>
<element name>' dialog, in the same way
as you create Maintenance items.
Create a new Risk/Metric/Effort item,
using the '<type>' dialog.

Modify
Selected

Update the selected Decision/Event item,
using the '<type> details for <element
type> <element name>' dialog.
Update the selected Risk/Metric/Effort
item, using the '<type>' dialog.
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Create as
New Element

Create a new element based on the
Project Decision/Event item, in the same
way as you generate elements from
Maintenance items.

Print List Print the list of items.

Delete Delete the selected item from the list.

Notes

Click on an element in the Browser window to switch to·

the project management items for that element in the
Project Tools window

Columns in the item list can be reorganized, added,·

removed, grouped, filtered and sorted using the options
provided in the List Header facilities

Right-click on the list to view the context menu, which·

you can use to also add and delete items in the window

You can move Decision and Event items between·

elements; see the Move Decisions/Events Between
Elements Help topic
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Move Decisions/Events Between
Elements
A Decision or Event you define for one element might be
usefully moved to another if, for example, you are moving
your model through stages in a lifecycle or, indeed,
modeling a lifecycle. It is possible to simply drag a Decision
or Event from either the appropriate tab of the Project Tools
window or the 'Details' tab of the Inspector window, onto a
different element on a diagram.

Access

From the Browser window, open the diagram containing the
target element, then click on the element from which to
move the Decision or Event. It is convenient to have both
source and target elements on the same diagram, but it is
possible to select the source element in the Browser window
or on a different open diagram.

It is also convenient to have compartments enabled on the
target element, with the 'project'  compartment selected, so
that you can observe the addition of the moved item.
(Right-click on the element and select 'Compartment
Visibility', then select the 'Project' checkbox.)

Ribbon Start > Application > Design > Browser >
Element - expand the 'Project' category
or
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Construct > Project Management >
Decisions > Show Decisions Window
Construct > Project Management >
Events > Show Events Window

Keyboard
Shortcuts

Alt+2 | Project > Decisions   or   > Events

Move the Decision or Event to the Target
Element

Click on the item that you intend to move, and simply drag
it onto the target element. The item name will display in the
'project' compartment of that element. What you would
observe might resemble this illustration.

(c) Sparx Systems 2025 Page 107 of 109



Tasks & Resources 2 September, 2025

(c) Sparx Systems 2025 Page 108 of 109



Tasks & Resources 2 September, 2025

(c) Sparx Systems 2025 Page 109 of 109


	Tasks & Resources
	Project Resources
	Resource Allocation
	Assign Multiple Resources

	Effort Management
	Risk Management
	Metrics
	Show Project Items in a Diagram 
	Effort Types
	Metric Types
	Risk Types

	Project Task Allocation
	The Project Gantt View
	Resource View
	Element View
	Report View

	Progress Bars
	Using Progress Bars

	Personal Tasks
	Review Allocated Work
	Monitor Your Tasks

	Project Tools Window
	Move Decisions/Events Between Elements



